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CHAPTER

ONE

GENERAL INFORMATION

1.1 About Program

ActiveMap Desktop is part of a multi-component web-based ActiveMap system for remote
employee management.

ActiveMap is an online system for organizing the interaction between field workers and the
dispatcher (task coordinator). The system provide the ability to plan and manage the pro-
duction work, as well as operational quality control of the field service.

Capabilities of ActiveMap:

• Flexible customization to meet the needs of the company.

ActiveMap can be adapted to any business process. A list of work types, stages and deadlines
can be set up for each organization.

• Adding tasks and controlling their execution.

The system allows to add operational and planned tasks, including scheduled tasks on a given
template.

• Object inventory.

ActiveMap helps carry out an inventory of objects: updating information on the status of
existing objects, identifying nonexistent and creating new objects.

• Control of field employees.

The system helps to control employees with real-time tracking of the location, viewing the
history of their movement and recording the execution of requests.

• Convenient and quick interaction between field employees and work coordinators.

ActiveMap speeds up the process of exchanging results between the field employee and the
work coordinator. The coordinator can promptly update task information, which is immedi-
ately displayed to the field employee. The coordinator also can quickly return the job to the
fieldworker for execution based on the results of the fieldwork.

• Using photo and video fixation materials and GLONASS/GPS data.

The system makes it possible to fix the fact of work fulfillment by means of photos, video
recordings, location data. This gives the opportunity to avoid field inspection of executed
orders.

• User rights configuration.
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The system gives the possibility to configure user rights. Each user is assigned a certain
role. The role of the system user affects access to the list of tasks, editing and management
of these tasks. The roles are from simple users to the administrator of the entire system.

• Displaying service objects on a map.

ActiveMap allows to create tasks on the basis of service objects with automatic filling of
coordinates and task fields.

• Creating electronic documents.

The system allows to create reports on the work with tasks and user activity based on the
document form of the organization, as well as invoices issued by field employees.

More information about the comprehensive capabilities of the ActiveMap system can
be found on the website of the Activemap Computer Systems Design company https:
//activemap.me/.

The ActiveMap Desktop software (hereinafter referred to as the Programme) is a desktop
application that implements the client part of the task management module of the ActiveMap
software suite. The Program is designed to solve the following tasks:

• setting tasks for employees of responsible organizations (with the ability to add media
files and perform georeferencing),

• task management and control over their execution,

• generating analytical and statistical reports on tasks.

1.2 Software and Hardware Requirements

To ensure stable operation of the Program, the personal computer must have the following
minimum specifications:

• Processor - Intel Core 2 Duo (or AMD Athlon 64) or higher,

• RAM - 2GB,

• Operating System - Microsoft Windows 7 and above,

• Microsoft .NET Framework 4.6.1.

1.3 Installing the Program

To install the program on a user’s computer, follow these steps:

1. Click “How to start?” button on the top panel of the geoportal page in the “Map” mode.

2. Select ActiveMap Desktop from the list of suggested modules.

3. Click “Download”. The setupActiveMapDesktop.exe file will be downloaded.

4. Run the setupActiveMapDesktop.exe file, which calls the ActiveMap Desktop installa-
tion wizard (Fig. 1.1).

5. Click “Next” to go to the window with the text of the license agreement. After reading
the text of the agreement, click “Accept” to continue the installation or “Cancel” to
terminate the installation of the Program.

1.2. Software and Hardware Requirements 2
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Fig. 1.1: Launching the ActiveMap Desktop installation wizard

6. After clicking the “Accept” button you will be taken to the ActiveMap Desktop installation
folder selection window (Fig. 1.2). By default, the installation wizard will suggest placing
the program file in the C:/Users/User_name/Documents/Activemap Computer Systems De-
sign/ActiveMap Desktop folder. You can choose another folder by clicking “Browse. . . ”.

Fig. 1.2: Window for selecting the folder for installing the Program

7. After selecting the folder, click “Install”.

1.3. Installing the Program 3



CHAPTER

TWO

WORKING IN THE PROGRAM

2.1 Starting the Program

After completing the installation, a window will appear asking you to run the Program (Fig.
2.1). Click “Yes” to start the Program.

Fig. 2.1: Starting the programme immediately after installation

If you click “No” when prompted to start the Program, you can click on the ActiveMap
Desktop shortcut, automatically created on the desktop after installation (Fig. 2.2).

Fig. 2.2: Program shortcut on the desktop

The authorization window will open (Fig. 2.3). The client server will be listed in the login
options line. You need to enter your username and password. There is also an option to save
the specified username and password by checking the “Save password” box. Passwords are
stored in encrypted form.
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Fig. 2.3: Authorisation window

When launching the Program for the first time or if updates are available on subsequent
launches, a window will appear after clicking “Continue” asking you to install the update
files (Fig. 2.4).

Fig. 2.4: Update installation window

After the updates are downloaded, the Program user interface will open with a set of features
corresponding to the user’s access rights.

Data access settings are set by the administrator individually for each user depending on
his/her role. Roles differ from each other by the set of actions they can perform in the system.
Roles are assigned by administrators when creating user accounts. There are the following
role types:

• “Administrator” creates users with any role, reference tables for tasks (types of work,
stages, priorities, additional fields, stickers), distributes access rights to layers and re-
ports.

• “Cluster Administrator” creates organizations in his cluster, users with the Cluster
Administrator, Organization Administrator, Cluster Inspector, Organization Inspector
and Organization User roles. Allows users to view and manage the tasks of other or-
ganizations in their cluster, to access layers and reports in their cluster.

• Organization Administrator creates users with the Organization Administrator, Or-
ganization Inspector, and Organization User roles. Allocates access rights to layers
and reports to users in their organisation. Corrects tasks if necessary. Returns tasks for
revision.

• “Cluster Inspector” checks, assigns and completes tasks within the cluster.

• “Inspector of the organization” checks, assigns and completes tasks within the de-
partment.

2.1. Starting the Program 5
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• “Chief Inspector” checks, assigns and completes all tasks.

• “Organization User” performs or creates tasks.

• “Client” creates tasks and does not see tasks created by other users of the organization.

2.2 Connection Settings

If internet access is provided through a proxy server, click on “Connection settings” in the
login window (Fig. 2.3) to bring up the “Connection settings” window with proxy server
settings (Fig. 2.5).

Fig. 2.5: Proxy server settings

In this window you can specify the proxy settings to be used in the network and click “Ok”
to save the settings.

2.3 User Interface of the Program

The Program interface includes the following elements (Fig. 2.6):

1. Toolbar - provides access to all features of the Program in the form of a standard
hierarchical menu.

2. User profile – allows to enter and change information about the current user.

3. Notification tape - displays notifications about different events: performer’s leaving
the task area, overdue tasks and others.

4. Task search and filter area - provides the ability to filter the list of tasks for individual
needs.

5. Task list area – contains a list of all tasks loaded into the system, taking into account
the filter applied.

6. Task information panel – responsible for viewing detailed information on the task
and editing it.

2.2. Connection Settings 6
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Fig. 2.6: Elements of the main window of the Program

2.3.1 Toolbar

At the top of the Program window, there is a toolbar that contains the following sections
(Fig. 2.7):

Fig. 2.7: Toolbar

• “File”,

• “View”,

• “Options”,

• “Filters”,

• “Reports”,

• “Schedules”,

• “Layers”,

• “Service objects”,

• “Help”.

2.3. User Interface of the Program 7
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In addition to standard sections, the toolbar may contain a “Plugins” section.

The “File” menu section contains the following tabs (Fig. 2.8):

Fig. 2.8: “File” menu section

• “Update” - instant update of service data used in tasks (types of work, steps, priorities,
lists of layers and rights to them) by synchronizing with the server;

• “Clear layers cache” - deletes layer data or layer files saved on the user’s PC, including
the basemap cache;

• “Clear task cache” – deletes data and task files stored on the user’s PC;

• “Exit” – terminates the work in the Programme.

The “View” menu section contains the following tabs (Fig. 2.9):

Fig. 2.9: “View” menu section

• “Tasks map” - view tasks on the map in a separate window according to the geographic
location specified in the task (Fig. 2.10).

2.3. User Interface of the Program 8
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Fig. 2.10: “Tasks map” window

Working in the “Tasks map” window is described in detail in the Task map (page 84) section.

• “Select downloaded tasks” - select all tasks displayed in the task list area;

• “Mode of work with task templates” – view and edit task templates created according
to the schedule;

• “Use the classic view of the main window” - switch between the new task list interface
and the old one (more details in the Task list area (page 25) section).

The “Options” menu section contains the following tabs (Fig. 2.11):

Fig. 2.11: “Options” menu section

• “Loading from GPS camera. . .” – loads tasks and photos with geographic tags (Fig.
2.12). The process of adding tasks in this way is described in details in the Create tasks
by uploading geotagged photos (page 96) section.

2.3. User Interface of the Program 9
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Fig. 2.12: Loading from GPS camera

• “Import” - mass loading of tasks into the system from MS Excel. The section contains
second level tabs: “Import from MS Excel”, “Import template tasks from MS Excel”,
“Update tasks from MS Excel” and “Save template” (Fig. 2.13).

Fig. 2.13: Data import

For importing tasks or task templates from MS Excel, download a template with examples,
prepare a file for import using the template, and upload the completed file into the program.
To update tasks from MS Excel, you need to export the required tasks, make changes, and
upload the completed file using the “Update tasks from MS Excel” tool. More detailed
information about the task import process is described in the section Mass task creation and
updating using an Excel spreadsheet (page 98).

Note: If a filter has been applied to the table, the System offers to download tasks using
this filter.

2.3. User Interface of the Program 10
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In all standard windows for selecting or saving a file, the path is remembered in order to
open the same folder when you access it again.

• “Export” – export data to MS Excel file (Fig. 2.14).

Fig. 2.14: Data export

The data is exported taking into account the filter applied to the tasks. The export process is
described in more detail in the section Task list area (page 25).

• “Settings” - management of ActiveMap Desktop settings. The section contains second
level tabs (Fig. 2.15):

Fig. 2.15: “Settings” tab

• “Program Settings . . . ” - opens the main program settings window, including task set-
tings, geodata, image compression parameters, task cache, notifications, as well as
language settings (more details see in the Internal settings (page 53) section). The pa-
rameters changed in the program settings window are used by default the next time the
program is opened (Fig. 2.16).

2.3. User Interface of the Program 11
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Fig. 2.16: Settings window

• “Log management. . . ” - opens the window for viewing and managing logs (Fig. 2.17).
In the window you can set the logging level and view the contents of the log files.

2.3. User Interface of the Program 12
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Fig. 2.17: Viewing and managing logs

• “Connection settings. . . ” - opens a window with connection settings, including login
parameters (server address, username and password) and proxy settings (Fig. 2.18).

Fig. 2.18: Connection settings window

Passwords in the configuration file are stored in encrypted form. The proxy settings window
was described earlier in the Connection Settings (page 6) section.

The “Filters” menu section contains the following tabs (Fig. 2.19):

Fig. 2.19: “Filters” menu section

2.3. User Interface of the Program 13
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• “Task filter” - a list of saved filters. To apply one of the filters, simply select it from
the list.

• “Save filter” - saves the current configuration of the task filter area. Working with the
task filter area is described in detail in the Task search and filter area (page 22) section.
To save the filter, enter its name and click “Save” (Fig. 2.20).

Fig. 2.20: Filter saving window

• “Restore my filter” - returns to default filter values. This tab is active if a default filter
is set. The default filter is assigned in the filter manager window.

• “Cancel the filter filling when the application is launched” - disables default filter
on application startup. This tab is active if a default filter is installed. The default filter
is assigned in the filter manager window.

• “Open the filter manager” – opens “Filter manager” window (Fig. 2.21). Here you
can set a default filter, rename, edit, and delete existing filters. If a default filter is set,
it is highlighted in bold in the list.

Fig. 2.21: “Filter manager” window

The “Reports” menu section (Fig. 2.22) opens a window with a list of reports, where you can
select the time interval for the report generation and the format of the uploaded file (*.pdf,

2.3. User Interface of the Program 14
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*.doc, *.xls, *.rtf). Some reports require additional parameters to be entered.

Fig. 2.22: “Reports” window

To start generating a report, after selecting the time interval and format of the uploaded file,
you should click “Create report (PDF/EXCEL/WORD(2007)/rtf)”. The “Generated reports”
block displays the report generation process. When the report is ready, the file becomes
available for viewing. Depending on the selected format, the report file can be opened in
its default application (for example, *.doc - in Microsoft Word) and saved on the user’s
computer.

The “Schedules” menu section contains the following tabs (Fig. 2.23):

Fig. 2.23: “Schedules” menu section

• “Schedules management" - opens the “Schedule list” window for creating, searching,
editing and deleting schedules that allows to create tasks based on templates at a certain

2.3. User Interface of the Program 15
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point in time with the required frequency (Fig. 2.24).

Fig. 2.24: “Schedule list” window

Schedule management is described in detail in Working with existing schedules (page 107).

• “Add to new schedule" – opens the “Schedule creation” window to add tasks selected
in the list to a new schedule (Fig. 2.25).

Fig. 2.25: “Schedule creation” window

2.3. User Interface of the Program 16
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The process of adding tasks to a schedule is described in section Adding tasks to a new
schedule (page 105).

The “Layers” menu section opens a window for enabling various groups of layers and se-
lecting a basemap (base layer) (Fig. 2.26). After checking the boxes in the layers window,
the objects of the selected layer will be displayed in the “Task map” window, in the “Map”
tab of the task information panel, as well as in a table view of other layers.

Fig. 2.26: “Layers” window

The “Service objects” menu section contains tabs with the names of service object layers
and a tab for importing a new table with service objects from MS Excel (Fig. 2.27).

Fig. 2.27: “Service objects” menu section

2.3. User Interface of the Program 17
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Clicking on any of the tabs with the name of the service object layer opens a window with a
list of objects in the selected layer and a map with their location marks (Fig. 2.28).

Fig. 2.28: “Service Objects” window

When you switch to the tab for importing a table from MS Excel, a file opening window will
appear. The process of searching, adding, editing and deleting service objects is described in
detail in the Working with service objects (page 62) section, creating tasks linked to service
objects - in the Creating tasks in the Service object window (page 101) section.

The “Help” menu section contains one tab (Fig. 2.29) - “About the program. . .” for viewing
information about the current and previous versions of ActiveMap Desktop (Fig. 2.30).

Fig. 2.29: “Help” menu section

2.3. User Interface of the Program 18
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Fig. 2.30: “About” window

To the right of the menu sections there is a search bar for objects in layers (Fig. 2.7). When
placing the cursor in the search field, the list of layers used for the search is displayed (Fig.
2.31). By default, these are service object layers.

Fig. 2.31: Extended search field for objects in layers

To exclude a layer from the search, just click on next to the layer name. To include
additional layers in the search, click on the arrow to the right of the selected layer names - a
drop-down list of available layers will appear (Fig. 2.32).

Fig. 2.32: Full list of layers available for object search

2.3. User Interface of the Program 19
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The search results display the title and subtitle of the object (Fig. 2.33).

Fig. 2.33: Object search results

2.3.2 User profile

If you click on the user name displayed in the top right corner of the Program window, a
window with information about the current user appears (Fig. 2.34).

Fig. 2.34: User profile

The following information may be displayed in the window:

• User login,

• Full name,

• Organization,

• Role,

• Email,

• Phone number.

On the left side of the profile window, there is an avatar and a label with additional infor-
mation (such as the user’s smartphone model). To replace the avatar, click “Change” and
upload a new image from the user’s computer. To delete the current image without replacing
it with another, click “Delete”.

Clicking on the “Edit” line will open the “Profile edited” window (Fig. 2.35).

2.3. User Interface of the Program 20
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Fig. 2.35: “Profile edited” window

Here you can change the user’s name, user type, password and, if authorised, email, phone
number, and user tags.

2.3.3 Notifications tape

Clicking on the “Notifications tape” line in the upper right corner opens a window that dis-
plays a list of notifications about various events: performer leaving the task area, overdue
tasks, etc. (Fig. 2.36). To the right of the “Notification tape” line the number of new notifi-
cations is displayed. Unread notifications are marked with one grey tick, readed ones with
two green ticks.

Fig. 2.36: Notifications tape

2.3. User Interface of the Program 21
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If there are no events, the window remains empty. To stop receiving notifications, click on
the pause sign, to resume - on the play sign. To delete received notifications, click “Clear”
in the lower right corner of the window.

2.3.4 Task search and filter area

The task search and filter area is designed to search for tasks in the general list using various
search parameters (Fig. 2.37).

2.3. User Interface of the Program 22
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Fig. 2.37: Task search panel

In the upper part there is a field for contextual search of tasks by task number, title, de-
scription, and URL generated in the task properties. To search for a task, enter the num-
ber/description of the task or part of it in the search field. The list of tasks that match the

search query is displayed (Fig. 2.38). To remove the task filters, use the or button.

2.3. User Interface of the Program 23
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Fig. 2.38: Displaying tasks that meet the conditions in the list

The following sections of the filter panel are used for advanced filtering:

• “Task’s parameters” - search by date of creation and update, due date, by task overdue.

• “Assigned to organization” – search for the organization to which tasks are assigned
(quick search bar and selection of several organizations is available). Organizations are
grouped into clusters. In addition to selecting organizations from the list by checking
boxes, you can use the context menu with a list of commands used inside the “Assigned
to Organization” section:

– Select only this line;

– Select everything except this line;

– Select all;

– Reset all selected.

To open the context menu, place the cursor on the line with the organisation name and right-
click (Fig. 2.39).

Fig. 2.39: Context menu in the task filter panel section

• “Assigned to performer” – search by the user to whom tasks are assigned (quick
search bar and multiple user selection is available). Also you can use the context menu,
similar to the one described above.

2.3. User Interface of the Program 24
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• “Task’s creator” – search by the user who created the tasks (multiple selections are
available).

• “Creator organization” – search for the organization on behalf of which the tasks
were created (multiple organizations can be selected).

• “Steps” - search for the selected step (multiple steps are available), you can use the
context menu to select.

• “Priorities” – search by selected priority (selection of several priorities is available),
you can use the context menu to select.

• “Types” - search by type of work (a quick search bar by type and selection of several
types of work is available), you can use the context menu to select.

• “Statuses” – search by status (selection of one or all available stages is available).

• “Custom fields” – search by value in the selected custom field (multiple search fields
are available).

• “Service objects” – search for the specified object from the layer of service objects
created in the system.

• “Contracts” – search for contracts created in the system.

• “Photos” - search by the number of photos added to the task and the assessment of the
coincidence of photo results (comparison for similarity with a photo sample). When
searching by the number of photos, only the photos added after the task was created
are taken into account, not the total number of photos in the task. Quick filters can be
used to speed up the search: “Not added” (no added photos), “Added” (there are added
photos), “Specified quantity added” (greater than or equal to the entered value). When
searching by the percentage of photo similarity, quick filters can also be used: “No
marks”, “Bad”, “Good”. The threshold level is set up in ActiveMap Web (the “Mobile
application” -> “Comparing photos” -> “Positive percentage of photo comparison”
section) and can be adjusted during the work session with the slider. The filter is set to
the minimum value specified on the task cover.

Note: The parameters are customised to suit the individual company’s business area.

2.3.5 Task list area

The central part of the Program screen displays all tasks available to the user (Fig. 2.40).
The ability to view and edit tasks is determined by the user’s role in the system. When a
filter is applied, the list displays tasks that meet the specified parameters.

The new default view of the main window (Fig. 2.40) displays the following information for
each task in the list:

• photo (if attached to the task) with or without the rating of photo similarity;

• number of attached files;

• number of unread messages in the task (in the blue circle on the right side of the list);

• color indication of lines with steps of execution.
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Fig. 2.40: Task list, new view (used by default)

In the classic view of the main window, task cards in the list are colored depending on the
steps of execution without displaying photos and the number of unread messages (Fig. 2.41).
To switch to the classic view, go to the “View” menu section and click on “Use the classic
view of the main window” or set the classic view of tasks in the program settings window
(more details in the Program settings (page 53) section).
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Fig. 2.41: Task list, classic view

At the top of the task list area, the following buttons are located:

• “Create task” – adding new tasks (detailed in the Adding new tasks
(page 91) section);

• “Tasks map” – opening the “Task Map” window (detailed in the Task map
(page 84) section).

• “Export to Excel” - exporting the current task list with the ability to choose the
exported fields (Fig. 2.42) to a Microsoft Excel document - when exporting, the filter
and sorting parameters of tasks are taken into account (Fig. 2.43).
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Fig. 2.42: Selecting the fields to be exported

Fig. 2.43: Data export to Microsoft Excel

To speed up frequently performed actions on exporting, you can save the set of task fields
selected for export. To do this, mark the main and custom fields in the lists for export, click

“Add” , enter the name of the set, and click “Apply”. A message about adding a new
export setting appears (Fig. 2.44) and the name of the settings set is displayed in the drop-
down list of saved configurations.
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Fig. 2.44: Message about the successful addition of a new export setting

You can change , rename or delete the saved set if necessary.

• “Sorting” - ordering the general list of tasks by the date of update (this sorting is
used by default), by task number, by title, by creation date, by update date, and by the
deadline (Fig. 2.45) in ascending (by default) and descending order (Fig. 2.46).

Fig. 2.45: Selecting the type of task sorting

Fig. 2.46: Selecting the order in which tasks are sorted

You can select one or more tasks from the task list by checking the box next to the task
number. You can also select all loaded tasks by clicking on the corresponding line at the
bottom of the list area (next to it, information about the number of loaded and selected tasks
is displayed, Fig. 2.47). By default, 100 tasks are loaded. If you need to select more, you
should scroll down the list.
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Fig. 2.47: Selection of loaded tasks

2.3.6 Task information panel

The “Task information” panel includes the following tabs (Fig. 2.102):

• “Information”,

• “Map”,

• “Custom Fields”,

• “History”,

• “Relations”,

• “Service Objects” (optional).

2.3.6.1 “Information” tab

The “Information” tab contains the following detailed information about the task (Fig. 2.48):

• Task number;

• Contract number and name (if applicable);

• Task author;

• Time remaining until task deadline;
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• Task title;

• Task description;

• Priority;

• Type of work;

• Task creation date;

• Organization and performer of the task;

• Task execution step;

• Creation date;

• Deadline for completion;

• Attached files (photos, audio files, video files, documents).
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Fig. 2.48: “Task information” panel, “Information” tab.

The “Information” tab contains the task management panel, which includes the following
options:

• Assign/change the organization responsible for executing the task;

• Assign/change the performer (employee of the organization);

• Change the work step;

• Change the task status (refused, in progress, completed);

• Delete the task (only users with administrative access rights have this capability).

A user with full permissions to edit tasks can change all the parameters of the task listed
above, except its creation date, as it is automatically generated and does not require editing.
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To save the changed parameters, click “Save” in the lower right corner of the window.

In the upper left corner of the “Information” tab, to the left of the title with the task number,

there is a button that allows copying the link to the task to the clipboard. The link
contains the server address and task number.

In the upper right corner of the “Information” tab, there is a “Print task” button which is
used to generate a report with detailed information about the task, including the values of the
main and custom fields, photos, map, and history of changes. The display of the map with
the location of the task point and the geolocation of the photos in the report is controlled by
the setting in ActiveMap Web: “MapMessages” -> “Task Printing” -> “Show Map”. The
report can be sent to a printer or saved in any convenient format on the PC.

Media files

At the bottom of the “Information” tab (Fig. 2.48), there is a field with attached files. It
contains the following tabs:

• “Photos”,

• “Files”,

• “Audio”,

• “Video”.

The tabs contain a list of files attached to the task. The files are arranged in tabs according
to format. A single right-click on the tab area outside of a file will bring up a context menu
that allows to sort (Fig. 2.49) and group files (Fig. 2.50) attached to the task, as well as copy
and paste new files into the task. The file grouping and sorting settings of the selected task
are retained even when you switch to this tab in the future.

Fig. 2.49: File sorting context menu

Fig. 2.50: File grouping context menu

To open a file, double-click the left mouse button.

At the bottom of the tab, there are “Add”, “Scan”, “Download”, and “Remove” buttons.
When you click the “Add” button, a window for selecting a file located on your personal
computer appears. After selecting the desired file and clicking the “Open” button, the file is
uploaded to the Program and attached to the task.
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When you click the “Scan” button (this button is only available in the “Photos” tab), a win-
dow for selecting a scanning device opens. After selecting and configuring the scanning
parameters, the image is uploaded to the Program and attached to the edited task.

The “Download” button is used to save the file to a personal computer. The button becomes
active only after selecting a file. After clicking on it, a window for selecting the directory
for image saving appears.

The “Remove” button is used to delete selected files from the Program.

A single right-click on a file brings up a context menu offering save, copy, delete, get infor-
mation about the file, or move the file to a group (Fig. 2.51).

Fig. 2.51: File context menu

When using the built-in camera of the mobile application, the System records the date and
time of the photo, the time zone of the mobile device at the time of shooting, which are
overlaid on the photo (Fig. 2.52).
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Fig. 2.52: A photo with a date and time stamp

The following information may be present in the window for viewing an attached image:

• Image sticker is a text note on a photo. It is used to mark “before” and “after” statuses
in tasks, to highlight a sample for creating photos, and to group images in the view
window. The sticker name is displayed above the selected photo. If there are more
than 20 stickers, a search option for stickers appears in the file context menu.

• The “Used” and “Result” indicators allow to see the links between the photo and the
sample it was taken on (Fig. 2.53).

Fig. 2.53: Information about photolinks

• Statistics on the use of photo samples by sticker (Fig. 2.54).

2.3. User Interface of the Program 35



ActiveMap Desktop user manual 3.32.1

Fig. 2.54: Statistics on the use of photo angles

• Geolocation sign is displayed when the task has coordinates. When hovering over
it, the distance to the task point is shown (Fig. 2.55). The color of the geolocation
sign corresponds to the distance of the photo from the geozones of the task point (by
default, the radius of the geozones is 150 m, this value can be changed in the settings
of ActiveMap Desktop in ActiveMap Web – see more in External settings (page 55)
section).

Fig. 2.55: A photo with a geolocation tag

• Rating of photo-result matching carried out by a neural network. The green back-
ground color indicates the achievement of a positive percentage of comparison between
two photos. Threshold values for percentages are set in the mobile application settings
section on ActiveMap Web. If values are not set or there is no access to the settings,
the background color is gray.
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Fig. 2.56: A photo with a rating of photo-result matching

Video files attached to the task can be of two types: normal video and timelapse video (time-
lapse) taken with the phone camera from the ActiveMap Mobile application. A timelapse is
a video created from a series of photos taken by a camera over a long period of time.

When capturing timelapses in ActiveMap Mobile, the geographical coordinates of the de-
vice’s movement are simultaneously recorded, making it possible to create tasks in the desk-
top app with the image obtained from frames of this video and its geoposition attached.
Timelapse capture in the ActiveMap Mobile app becomes possible by enabling the appro-
priate settings in ActiveMap Web (section “Management” -> “Settings” -> “Mobile App”
-> “Timelapse Video Settings”).

Normal video attached to the task can only be downloaded and viewed using the default
Windows video player for such file types. For timelapse videos, it is possible to view the
saved video in the built-in player with simultaneous viewing of the device’s movement track
and its location at the time of recording the current frame (Fig. 2.57).
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Fig. 2.57: View a timelapse at the same time as the track

The window displays information about the actual duration, date and time of video recording,
as well as the ability to control the playback speed and create a task with frame attachment.

If recording was paused during shooting, this section will be marked in the track with red
dots, and the length of the video recording and its distance will have two values: working
(including a pause) and total (without pause taken into account).

In the video view mode, you can create a task with reference to the current frame and its
coordinates on the video. To do this, click the “Create task” button on the menu panel. The
task creation form opens with the addition of the video frame as a photo, and the coordinate
of this frame becomes the task location. See Creating tasks using a time-lapse recorded in
ActiveMap Mobile app (page 97) for more information on creating tasks based on timelapse.
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Invoice

The “Invoice” button is located next to the ‘Save’ button in the lower right corner of the
“Info” tab. It is intended to generate an invoice directly during the task execution at the
customer’s site by creating a list of required materials and services with their quantities.
Clicking on the button opens a web page where you can select the necessary materials and
services from the refrence table (dictionary) and see their total cost (Fig. 2.58).

Fig. 2.58: Generating an invoice

To include materials and services in the estimate, click ‘Add item’ and select the required

item from the list. Here you can use the search bar and filter by group (Fig. 2.59). Click
to filter. A field for selecting the group of materials and services appears on the left. Select
one of the values from the drop-down list, click the plus sign to the right of the group name,
and then click “Apply”. The filtered list is displayed, from which materials and services can
be selected.
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Fig. 2.59: Filtering materials and services

After selecting, you have to specify the quantity of each item. Adding new items to the ref-
erence tables (dictionaries) of materials and services and their groups is done in MapEditor.

The “Save” button allows to save the list and quantity of selected materials and services to
the database without generating an invoice file. The “Generate invoice” button generates
and attaches an invoice in PDF format to the task (Fig. 2.60).
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Fig. 2.60: Invoice for printing

The generated invoice is displayed in the “Information” tab, “Files” section (Fig. 2.61).
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Fig. 2.61: Invoice attached to the task

2.3.6.2 “Map” tab

The “Map” tab is designed to view the address of the task, the places where the photo at-
tached to the task was taken, the track of the movement of the task performer and the layers
available to the user (Fig. 2.62). If the user has appropriate rights, he/she can add/modify
the address of a task location. To add/modify an address simply mark the place on the map
by double left mouse button click or enter address in the search field and press “Save”. The
indicated place on the map will be marked.
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Fig. 2.62: “Map” tab

In addition to the geo-referenced task and the attached photos, the map also shows the po-
sition of the performer of this task with a time and date stamp. Above the map, the address
and time of the performer’s location at that address are displayed.

In the top of the “Map” tab, there is a control panel for the performer’s track. By default,
the performer’s task data is displayed with a set period. The period corresponds to the date
of task creation and update. In addition, the period can be configured manually and remem-
bered so that it is automatically displayed when viewing the “Map” tab for all tasks. To do
this, check the corresponding box.

There are several buttons at the bottom of the map:

• – enabling the display of geometric fields (Fig. 2.63) with the possi-
bility of editing them (adding geometry). Works if tasks have custom fields of “Geom-
etry” type.
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Fig. 2.63: Displaying geometric fields

To enable the display of a particular field, check the box next to its name. Buttons
to the right of the name allow to add point, line and area objects to the map. Only one
geometry object can be stored in a field. When adding a second object, a message will
appear confirming the replacement of the geometry (Fig. 2.64)

Fig. 2.64: Message about geometry replacement

The button allows to clear the geometric field. The button displays information
about the existing geometric object: vertex coordinates, length/area for linear/planar objects,
number of vertices, name (by default - date of object creation), description (Fig. 2.65).

2.3. User Interface of the Program 44



ActiveMap Desktop user manual 3.32.1

Fig. 2.65: Information about a geometric object

The buttons under the field names allow to edit the geometry of objects:

- add node, - move node, - delete node.

• – switching on the mode of displaying information on the selected object, provided
that the layer is enabled (Layers -> Select the required layer).

When clicking on an object in the information display mode, a window opens with a list of
objects found under the cursor (Fig. 2.66).
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Fig. 2.66: Displaying layer object information

When you click the button to the right of the object name, the edit window will open,
where you can edit the attributes and geometry, attach media files to the object (Fig. 2.67).
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Fig. 2.67: Layer object edit window

• – opening a window for manual input/copying of coordinates.

• – hiding/showing the label of the places where the photos for the task were taken.

• – hiding/showing a video track made using timelapse recording.

• – showing user names on the map.

2.3.6.3 “Custom fields” tab

The “Custom fields” tab is designed to work with attribute fields that can be customized in
the system to suit the needs of the project and linked to the activities. Custom fields can
contain data of the following formats:

• integer,

• boolean,

• float,

• date,

2.3. User Interface of the Program 47



ActiveMap Desktop user manual 3.32.1

• list,

• string,

• phone number,

• text,

• geometry (fields of this type are displayed in the “Map” tab).

For all custom fields (except for the “geometry” field), a default value can be specified.
Display settings for a geometric additional field, specified when viewing one of the tasks,
are saved when switching to another task.

2.3.6.4 “History” tab

The “History” tab is intended for viewing information about changes made and comments
added to the task in the form of messages. Messages can come from users or be generated
by the system. To send a comment, enter the text and click “Add” or press the “Enter” key
(Fig. 2.68). To move the cursor to the next line, you can use the keyboard shortcut “Ctrl” +
“Enter”.
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Fig. 2.68: “History” tab

When you hover the cursor over a message, the “Reply” button appears (Fig. 2.69).

Fig. 2.69: “Reply” button when hovering over a message

A right-click on a message brings up a contextual menu that also allows to reply to the
message as well as copy its text (Fig. 2.70).
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Fig. 2.70: Message context menu

2.3.6.5 “Relations” tab

The “Relations” tab is intended for displaying and managing the link between the parent and
child tasks. At the bottom of the window there are buttons (Fig. 2.71):

• “Create task” - creating a child task in relation to the current task;

• “Open” - opening the selected task in a new window;

• “Update” - updating information in this tab;

• “Remove” - deleting the task from the system;

• “Detach” - removing the link between the parent and child tasks.
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Fig. 2.71: “Relations” tab

After clicking the “Create task” button, a window appears where you can specify which data
from the parent task should be copied to the child task.
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Fig. 2.72: Copying data from the parent task

2.3.6.6 Service objects tab

If a task was created with a link to a service object, a tab with the name of the layer associated
with the service object appears in the task card with information about the object (Fig. 2.73).
In this tab, you can enable or disable the display of empty fields.

Fig. 2.73: Service object tab
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2.4 Program settings

Program settings are divided into internal and external. Internal ones are executed directly
in ActiveMap Desktop, external ones - in other software products of the ActiveMap (in
ActiveMap Web).

2.4.1 Internal settings

To configure user settings within the Program, you have to go to the “Options” menu section,
select “Settings”, and then the “Program Settings” tab. This opens the Program Settings
window, which contains 2 tabs: “Main” and “Notification” (Fig. 2.74).

Fig. 2.74: “Settings” window, “Main” tab

The following flags (Fig. 2.74) can be enabled in the “Main” tab:

• Minimize the program instead of closing;

• Use all organizations;

• Show geodata files;

• Show data about current users location;

• Hide inactive users on the map.
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You can switch between new and classic task list view (more details in the section Task list
area (page 25)), configure tasks sorting in the list area (by task number, by title, by creation
date, by completion date, by update date: in descending order or in ascending order).

To change the language of the Program, you have to select one of the supported languages
from the drop-down list, click “Apply” and restart the application. To add new languages
to the Program, you need to upload a “.lang” file with the corresponding language to the
“Localization” folder located in the installed program directory. To generate a “.lang” file,
use one of the existing files in the “Localization” folder as a template. You can edit the file
with any text editor (such as “Notepad++”). The file contains all the words and phrases used
in the Program. Simply replace them with the words and phrases in the desired language.
When saving a new file, its name should have a similar format - “en-EN”. You can find a
full list of language codes for this format here: https://msdn.microsoft.com/en-us/library/
ee825488(v=cs.20).aspx. After the new file appears in the “Localization” folder, you need
to restart the Program.

In this window you can also set compression parameters for images attached to tasks (size
and quality) and configure the task cache size. To apply the changes, click “Apply” at the
bottom of the window. To change the language settings you also need to restart the Program.
To discard changes, click the “Cancel” button.

In the “Notification” tab, you can manage sound notifications in the Program (Fig. 2.75).

Fig. 2.75: “Settings” window, “Notification” tab
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The “Enable sound notifications” field allows to activate notifications for all events in the
Program for which they are provided. In addition, you can configure individual categories
of sound notifications:

• About new user comment – when adding a comment from a user (not a system com-
ment) to a task;

• About entering and leaving the zone – when a system comment about entering or
leaving the zone (task area) is added to the task (when the employee to whom the tasks
are assigned arrived at the work site or left it);

• About changes in the task - when changes are made to tasks that meet the specified
criteria. The user can filter tasks by ticking the required fields, for example, mark the
organization, type of work and step - in this case, all other changes to the tasks will not
be accompanied by a sound notification.

To apply the changes, click “Apply” at the bottom of the window. To discard changes, click
the “Cancel” button.

2.4.2 External settings

Some of the ActiveMap Desktop settings can be made in the associated software product of
the ActiveMap complex - ActiveMap Web. To do this, log in to ActiveMap Web and go to
the “Management” section, “Settings” block, and select the ActiveMap Desktop (Fig. 2.76).

Fig. 2.76: ActiveMap Desktop settings in ActiveMap Web

The section contains folders and subfolders where the settings and their values are located.

In order to add a new setting for an element inside a section, click the “+ Folder” button,
then “+ Setting”. Or go to the folder of interest and click “+ Setting”. A form opens with
fields to fill in (Fig. 2.77):

• “Key” – the name of the setting in Latin characters to be used in the system;
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• “Name” – the name of the setting to be displayed in the interface;

• “Type” – data type (string, integer number, logical value, real number).

Fig. 2.77: Creating a setting

To set a value for a setting, select the setting and click “+ Value”. This opens a window with
fields to fill in:

• “Value” - the value that the setting will be equal to in the system (depends on the data
type specified when creating the setting);

• “Organization” - select the organizations for which the setting will work;

• “User” - select users;

• “Role” - select roles;

• “State” - select task statuses.

Deleting basic settings is not available. Some of them can be edited. The availability of
editing is set in the database.

ActiveMap Desktop parameters configured in ActiveMap Web:

• Default values for:

– type of work;

– task title;

– organization-creator;

– priority;

– task text;

• Basemap of application:

– Name of the folder for the cache;
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– Projection of basemap (in PROJ.4 format);

– URL of TMS-service;

• ActiveMap Web layers displayed in ActiveMap Desktop (layer id);

• Task printing (map imagery in print form);

• Automatic filter application (TRUE/FALSE);

• Custom order of work types in lists (TRUE/FALSE);

• Photo capture radius for task area (in meters).

2.4.2.1 Default values

In order to specify the values to be automatically filled in when creating tasks, open the
“Default values” folder. The system allows to configure the following fields (Fig. 2.78) to
be filled in automatically:

• Type of work;

• Title;

• Creator organization;

• Priority;

• Text (task text).

Fig. 2.78: Setting default values

Let’s consider the process of setting new values for the “Work type” field as an example (Fig.
2.79). To set a value for a setting, select it, click “+ Value”, enter the work type ID in the
“Value” field, and select from the drop-down lists the organization, user, role, and task status
for which the default value will be used. After filling in the values, click “Save”. This way,
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when creating a task in ActiveMap Desktop, the “Work type” field will be automatically
filled in with the specified default value for users with an administrator role in the “Executor
Organization”.

Fig. 2.79: Setting a default value for the work type

To set default values for other fields in this folder, follow the same steps.

2.4.2.2 Basemap of application

This folder contains the following fields (Fig. 2.80):

• Name of the folder for the cache - folder for the map cache for ActiveMap Desktop use;

• Projection of basemap - basemap projection in PROJ.4 format;

• URL of TMS-service - link to the basemap layer.
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Fig. 2.80: Basemap settings

The system has basic settings for these fields. If necessary, you can enter your own values for
these parameters (similar to the process of setting new values, described in Default values
(page 57)).

2.4.2.3 Layers of ActiveMap Web

This setting allows to select layers to be displayed on the map by default in the task window
(Fig. 2.81).

Fig. 2.81: Configuring the display of ActiveMap Web layers in ActiveMap Desktop
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To do this, select the setting, click “+ Value”, enter the id of the required layers separated
by commas in the “Value” field (layers will be displayed on the map in this order), fill in the
remaining fields and click “Save”.

2.4.2.4 Printing tasks

In this folder, you can set task printing options - whether to include a map in the printed task
form. By default, the map display is disabled (Fig. 2.82).

Fig. 2.82: Setting the map display when printing a task

2.4.2.5 Apply filters automatically

It is possible to set the system to automatically apply a filter to tasks. By default, this setting
is enabled (Fig. 2.83).
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Fig. 2.83: Setting automatic filter

To set a new value for the setting, select it, click “+ Value”, toggle the switch in the opened
window, fill in the remaining fields, and click “Save”. If you leave the switch off and fill in
the remaining fields, a value is created that limits the use of the automatic filter. In this case,
the user have to click “Apply” in ActiveMap Desktop to enable the filter.

2.4.2.6 Photo capture radius for task area

The system has the ability to adjust the radius of the task area. The default radius is 150
meters (Fig. 2.84). You can optionally set a new value (similar to the process of setting new
values described in Default values (page 57)).
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Fig. 2.84: Setting the radius for task area

2.5 Working with service objects

Service objects are layers that contain objects of interest of the user’s organization, associ-
ated with its activities. In ActiveMap Desktop, you can view all tasks attached to a specific
service object within a layer. When creating tasks attached to such objects, the task fields are
automatically filled in according to the configured mapping (matching the layer attribute to
the task field). More information about creating tasks can be found in the section Creating
tasks in the Service object window (page 101).

Working with service objects is carried out in the “Service objects” menu section. The
section contains tabs with names of the service object layers and a tab for importing a new
table with objects from MS Excel. Switching to any of the tabs with layer name opens a
window with a list of objects of the selected layer and a map with their location marks (Fig.
2.85). This window is used to edit, add and delete objects as well as to create tasks linked
to service objects. The window contains the following elements:

1. Toolbar.

2. Filter area.

3. Table with a list of objects.

4. Map with object location marks and layers switched in the “Layers” menu section.
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Fig. 2.85: Service objects layer window

2.5.1 Filters in the service object layer window

You can use filters, sort table rows and select objects on the map to make it easier to find ob-
jects. Several filtering conditions can be specified by adding ordinary and combined filters.
Combined filters establish priorities for conditions (similar to parentheses). Figure Fig. 2.86
shows an example of the result of using ordinary filters.
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Fig. 2.86: Result of using ordinary filters

Figure Fig. 2.87 shows an example of the result of using the combined filter:
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Fig. 2.87: The result of using a combined filter

To remove values entered in the filter field, click “Clear”. To completely reset the filter

conditions, click “Close” to the left of the filter, and then click “Apply” to display rows
with all objects in the table.

Selecting an object on the map is done using the buttons “Select on map” , “Select on

map using rectangle” , “Select on map using polygon” and works as a filter for the
list of objects (after selection on the map, only rows with selected objects are displayed in
the table to the left of the map — Fig. 2.88). In order to clear the results of the “Select on

map” filter, click “Close” next to the red inscription “Selected on the map:”. In this
case, only the data of the “Select on the map” filter is cleared, the results of the main filter
are saved.
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Fig. 2.88: Selecting service objects on the map

2.5.2 Creating service objects

Single creation and mass loading of new service objects is supported.

2.5.2.1 Single creation of new service objects

To create a new service object, click “Add” at the bottom of the service object layer window

or mark the object’s position on the map using the tool. After performing any of these
actions, a window for creating a service object (Fig. 2.89) opens. The only difference is in
the absence or presence of the object mark on the map when the creation window is opened.
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Fig. 2.89: Service object creation window

In the creation window, you have to fill in the available fields (including the name of the
object), mark or edit the position of the object on the map. If necessary, you can attach files
to the object, add links to pages (Fig. 2.90). Files can be added by dragging them from an
open folder.

Fig. 2.90: Adding a page

To complete the creation, click “Save”. The created object is displayed in the table and on
the map in the service objects layer window
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2.5.2.2 Mass creation of new service objects

Mass loading of objects can be done either by creating a new table or into an existing ser-
vice object layer. You can import both previously saved layer templates and original object
data files. To save the layer template, go to the “Import” section of the service object layer
window, to the “Save template with examples” tab. A window opens to save the template.
Fill in and save the received template. All standard file selection or save windows remember
the path so that the same folder can be reopened.

To bulk upload objects to a new table, go to the “Service objects” tab in the main program
window, then select the “Import from MS Excel” tab and choose the desired *.xlsx file. A
window with table creation settings opens (Fig. 2.91). By default, the Program defines a
worksheet from which data is imported, as well as the range to be loaded. If necessary, you
can specify another range (the first row must be the header) and click “Recalculate”.

Next, in the preview window, match the file columns to the data type in the column and, if
available, select a geometry field in GeoJson format (for point, line and polygonal objects)
or in a combined latitude and longitude field format (for point objects). The same field can
be used both for specifying coordinates and for filling any layer field in the import window
via MS Excel file. If you deselect the type of data to be imported for a column by clicking on
the cross to the right of the data type name, the column will not be imported into the system.

Fig. 2.91: Window with settings for importing a file into a new table, “Main” tab

The window contains 2 tabs: “Main” and “Style”. In the “Main” tab, specify the name of
the table being created and the header field, as well as determine the cluster and group to
which it belongs. By default, the table name is taken from the MS Excel file name, and the
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first field with the “String” type is used as the header. Default values can be changed.

In the “Style” tab (Fig. 2.92) you can select geometry type (point, line, polygon) and style
of displaying objects on the map (for point objects: geometric symbols shape, size, trans-
parency, main symbol and stroke colour; for linear: transparency, thickness, main line and
stroke colour; for polygonal: transparency, main figure and stroke colour).

Fig. 2.92: Window with settings for importing a file into a new table, “Style” tab

After all the values are selected, click “Load” to start the import or “Close” to cancel. If
the “Load” button is not active, a message appears at the bottom of the window indicating
the reasons for the blocked state of the button. This message appears in the “Import/Update
Tasks”, “Import Excel Table”, and “Import/Update Objects” windows. Import is not possible
if the layer group is not specified (Fig. 2.93), or if there are multiple fields with the same
names in the imported table.
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Fig. 2.93: Import error - layer group not selected

After a successful import, the name of the new layer is displayed in the ‘Service Objects’
tab. Field mappings between the object and the task are automatically set up for this layer
(the task header is taken from the layer header, and the object coordinates are copied into the
task; other field mappings are configured separately). The current user uploaded the table
has full rights to view, edit, and manage the table. Default viewing rights for all user roles
are also provided.

To mass load objects into an existing service object layer, open the layer window, go to
“Import” section, “Import objects from MS Excel” tab and select the *.xlsx file of interest.
A preview window opens with file import settings (Fig. 2.94), where you can specify sheets
and cell range to be imported, match file and layer columns and select geometry field in one
of the formats: GeoJson (for point, line and polygonal objects), merged field or separate
latitude and longitude fields (for point objects).
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Fig. 2.94: Window with settings for importing a file into an existing layer

If the column names in the file and layer match, the program automatically maps them, that
can be edited manually. After specifying all settings, click “Load” to start importing the file.
The uploaded objects are displayed in the service object window. To cancel the import, click
‘Close’.

Important: Column headers are read from the first row of the imported *.xlsx file. The
presence of headers is necessary for import.

Warning: Before starting to load data into ActiveMap Desktop you should close the
imported file if it is open in external programs.

2.5.2.3 Copying existing service objects

To create a copy of an existing service object, select it in the object list or on the map, go to
the “Options” section and select “Copy” in the current layer window (Fig. 2.95).

Fig. 2.95: Copying of service objects
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A message appears confirming the copy of the object data (Fig. 2.96). You can also enable
copying of the files attached to the object here.

Fig. 2.96: Copying layer object data

After confirming the copy, a window for creating an object appears, where you can edit the
attribute information, location, add new or delete previously attached files. To complete the
copy, click “Save”, click “Close” to cancel.

2.5.3 Editing service objects

To edit a service object, double-left click on the object name in the list to open the object
editing window (Fig. 2.97).

Fig. 2.97: Service object editing window, “Data” tab
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The “Change” window contains the “Data” and “Assigned tasks” tabs. In addition to these,
there may be tabs with the name of related layers.

In the “Data” tab, you can edit the attribute data of the object, the position of the object
on the map, add a page, add, download or delete attached files using the context menu or
buttons at the bottom of the window. Files can be added by dragging and dropping from
an open folder. The “Download” and “Delete” buttons become active after selecting one or
more files.

In the “Assigned tasks” tab, you can view and edit all tasks associated with a given service
object (Fig. 2.98). To make the search easier, you can use the filters on the left side of the
window.

Fig. 2.98: Change service object window, “Assigned tasks” tab

If objects of the current (parent) layer are linked to objects of another (child) layer, an addi-
tional tab with the name of the linked layer will appear in the “Change” window. There can
be several such layers (and tabs). An example of such linkage is the link between the pillar
layer and the equipment layer located on those pillars, between the park layer and the bins
placed in the park. The link between the layers is made by a field with data type “Layer”
which is set up in ActiveMap Web and which is filled in when the object is created in the
child layer. The tab with the name of the linked layer displays information about the linked
object (Fig. 2.99).
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Fig. 2.99: Change service object window, tab with linked layer name

There can be several related objects. To facilitate the search among a large number of objects,
you can use the filter.

The buttons common to all tabs of the window are:

• “Create task” - used to create tasks with reference to the current service object (for
more details, see Creating tasks in the Service object window (page 101)).

• “Save” - allows to save the changes made to the service object.

• “Close” - closes the change window.

For mass editing of service objects, you need to:

1. Go to the “Export” menu section of the service objects window and select the “Export
to MS Excel” item. A window opens to save the file.

2. Open and edit the saved file.

3. Go to the “Import” menu section of the service objects window, select the “Update
objects from MS Excel” item and specify the edited file.
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2.5.4 Deleting service objects

To delete a service object, select it in the list by clicking on it once with the left mouse button

or on the map by clicking the “Select on map” button , “Select with a rectangle on the

map” button or “Select with a polygon on the map” button , and click “Delete” at
the bottom of the window. You can select multiple objects in the list by using the “Ctrl”
and “Shift” keys or the combination “Ctrl+A” to select all the objects in the list. After click-
ing “Delete,” a warning message will appear: “Do you really want to delete the selected
record/selected objects”? Press “Yes” to delete, “No” to cancel.

2.6 Viewing and editing task information

The ability to edit tasks created on the server is determined by the user’s role in the Program.
Most users have limited editing capabilities and can only edit certain task parameters (for
example, change the execution step, add media files and comments).

You can view information on an individual task and edit it in the following ways:

1. Enter the task number in the search bar and double-click on the task preview (Fig.
2.100). A separate task window opens (Fig. 2.101).

Fig. 2.100: Task search and preview

2. Click the button in the task list area to open a separate window for viewing
and editing the task (Fig. 2.101).
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Fig. 2.101: View detailed task information in a separate window

3. Double-click on the task icon on the task map to open a separate window for viewing
and editing the task, similar to Fig. 2.101. Details on working with the task map are
described in the section Task map (page 84).

4. Select a task in the task list area by left-clicking mouse button. The information is
displayed on the right side of the Program screen in the “Task Information” panel (Fig.
2.102).
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Fig. 2.102: Viewing detailed information about a task on the “Task Information” panel

The “Task Information” panel is described in detail in the section Task information panel
(page 30).

Only with this method (unlike the previous ones) it is possible to get a link to the task and
delete it.

2.7 Operations on selected tasks

2.7.1 Task list

When one or more tasks are selected in the task list area, marked with a checkbox, buttons for
performing various operations on the selection become active in the lower right corner of the
list area. Clicking the “Edit selected” button opens a window where you can modify main
and custom fields of the task (Fig. 2.103). Checkboxes next to the parameters that can be
changed activate drop-down lists with possible parameter values. After updating fields, the
corresponding record is displayed in the history of all tasks, even if this field is not available
for a particular task, but it has been included in the update list during filtering.
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Fig. 2.103: “Edit selected tasks” window

Clicking the arrow to the right of the “Edit Selected” button displays a drop-down list with
other operations (Fig. 2.104).

Fig. 2.104: Operations on selected tasks

• “Delete selected” - delete selected tasks.

• “Print the tasks” - generate a report file containing detailed information for each of
the selected tasks to be sent to print or saved in any convenient format to a PC.
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• “Export files” - upload files attached to the tasks. When you click on the button, a
window for browsing folders to save (Fig. 2.105) appears.

Fig. 2.105: Folder browsing window

After selecting a folder, the task file grouping window opens. By default, files are grouped
and saved in folders with the number and name of the task (Fig. 2.106). In the preview
window, you can see the full paths of the files.
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Fig. 2.106: Task file grouping window

You can specify additional grouping by one or more task fields from the drop-down list and
by stickers. This allows to create a more complex folder structure: folders with the name and
number of tasks are stored inside folders with the names of field values for grouping (Fig.
2.107).
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Fig. 2.107: Example of grouping task files by the “Types of work” field

• “Add to new schedule” - create a new schedule including the selected tasks as tem-
plates. Clicking on the appropriate list item opens the “Schedule creation” window
(Fig. 2.108). The creation of schedules is described in more detail in Adding tasks to
a new schedule (page 105).
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Fig. 2.108: “Schedule creation” window

• “Add to schedule” - add the selected tasks to the existing schedule. Clicking on the
button opens a window where you can select the schedule where the selected tasks are
included (Fig. 2.109), for details see Working with existing schedules (page 107).
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Fig. 2.109: Schedule list window

• “Change file stickers” – open a window for reassigning stickers, where you can select
files with a sticker, assign a sticker to the marked file types (Fig. 2.110).

Fig. 2.110: “Reassigning stickers” window
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2.7.2 Task map

The “Tasks map” button, located on the task list panel in the center of the Program screen,
is intended for working with tasks on the map.

Clicking the button opens the “Tasks map” window, displaying tasks, enabled layers and
System users on the map as different coloured symbols corresponding to the current status
(Fig. 2.111).

Fig. 2.111: “Tasks map” window

To display the user on the map, monitoring of the movement should be configured through
the system web interface (in ActiveMap Web). In the right part of the window there is a user
track panel, which allows to monitor the movement of performers for a certain period. This
period can be configured and remembered so that it is automatically displayed in the map
window for all tasks.

In the upper left corner of the task window screen, there is a toolbar with the following
buttons:

• - moving around the map;

• - point selection of tasks on the map;

• – selection of tasks on the map with a rectangle;

• - selection of tasks on the map by a polygon;

• - task execution order;
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• – activating the mode of displaying information on the selected object, provided
that the layer is enabled (Layers -> Select the required layer). The mode is described
in detail in “Map” tab (page 42).

If you press the task selection button and double-click one of the tasks on the map, a window
with the task information appears. When multiple tasks are selected on the map, buttons
for operations on selections become active in the lower right corner of the window: “Edit
selected”, “Delete selected”, “Print tasks”, “Export files”. They work similarly to the buttons
described in the Task list area (page 25) section.

At the bottom of the window, you can enable/disable the display on the map of:

• users,

• user captions,

• task captions,

• custom geometric fields.

The following display options for captions are available to the user:

• - task caption is not displayed;

• - task caption is displayed at a scale of 20000;

• - task caption is displayed at any scale.

The order of execution is implemented by changing the deadline for completing tasks. To
distribute the deadline for completing tasks, you have to:

1. Open the “Set Deadlines” window (Fig. 2.112) by clicking the button.
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Fig. 2.112: “Set Deadlines” window

2. Add tasks in one of the two ways described below:

2.1. Select multiple tasks on the map (Fig. 2.113).
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Fig. 2.113: Distribution of task execution order

2.2. Or add tasks from the Main window:

2.2.1. In the “Set Deadlines” window, uncheck “Add when select in map” (Fig. 2.114).
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Fig. 2.114: Removing the “Add when select in map” flag

2.2.2. Switch to the main window, select a task (select one task or tick multiple tasks) (Fig.
2.115)

Fig. 2.115: Selecting tasks

2.2.3. Click on “Add” in the “Set Deadlines” window (Fig. 2.116)
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Fig. 2.116: Distribution of the task execution order

You can move tasks up and down in the list using the up and down arrows .

3. Set the interval:

3.1. Select date and time range (Fig. 2.117).

Fig. 2.117: Selecting the period of task execution
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3.2. Click “Set Deadlines” (Fig. 2.118).

Fig. 2.118: Applying changes

3.3. Confirm the actions (Fig. 2.119).

Fig. 2.119: Confirmation of changes

As a result, the task deadlines are evenly distributed among the selected tasks within the set
time interval.

At the bottom of the window, the “Edit selected” button is duplicated (this button is also
located in the lower right corner of the task list area) (Fig. 2.120). Thus, you can select one
or several tasks on the map and apply mass changes to them, as well as delete or print them.

Fig. 2.120: “Edit selected” button in the “Task map” window
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2.8 Adding new tasks

You can add new tasks to ActiveMap Desktop in one of the following ways:

1. Using the “Create task” button on the “Task list” panel in the main window of the
Program.

2. By uploading georeferenced photos.

3. Based on timelapse video taken in the ActiveMap Mobile application.

4. By using excel-table (mass creation of tasks).

5. With linking to service objects.

2.8.1 Creating a task in the main window of the Program

To create a task in the main window of the Program, you should:

1. Click the “Create task” button located in the task list area in the central part of the
screen (Fig. 2.121).

Fig. 2.121: “Create task” button.

2. Fill in the fields in the “Create task” window that appears (Fig. 2.122). By default, the
following main fields are included:

• “Title”;

• “Priority”;

• “Type of work”;

• “Organization”;

• “Executor”;

• “Creation date”;

• “Deadline”;

• “Contract”;

• “Creator organization” (this field is only available to users with the Chief Administrator
and Chief Inspector rights);

• “Parent task”;

• “Service object”;

• “Text of the task”;

• add “Photo”, “Files”, “Audio” and “Video”.

In addition to the main fields shown by default, the task creation window may also include
custom fields.
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Fig. 2.122: “Create task” window

You can create tasks under a contract only during its validity period. A task is always cre-
ated within a contract cluster and assigned to the contract executing organization. If the task
executing organization is not specified, the contract executing organization is substituted. A
contract task can be created by the Chief Administrator and Inspector, Cluster Administra-
tors and Inspectors, and the Administrator and Inspector of the executing organization, if
the corresponding option is enabled for the contract. The administrator of the contracting
organization can create tasks based on service objects located in its organizations or cluster-
level service objects. The contract may specify service objects and types of work for which
tasks can be created. If the list of service objects is not empty, tasks can only be created for
objects on this list. If the list of types of work is not empty, tasks can only be created using
types of work from the list.

When the cursor is placed in the “Service object” field, a list of layers used for searching
appears (Fig. 2.123). By default, these are the layers of service objects.

Fig. 2.123: Extended search field for objects in layers
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To exclude a layer from the search, just click on next to the layer name. To include ad-
ditional layers in the search, click on the arrow - a drop-down list of available layers appears
(Fig. 2.124).

Fig. 2.124: Full list of layers available for object search

Clicking on the right side of the service object search field opens a separate window
for selecting the layer to search in. By default, only service object layers are enabled (Fig.
2.125).
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Fig. 2.125: “Select layer” window

To select from the full list of layers, uncheck “Only service objects” (Fig. 2.126).
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Fig. 2.126: Displaying all available search layers

After selecting the layer name and clicking “Select,” the layer window opens, where you can
find the object of interest (manually or using filters).

When creating a task, you can specify its geographic location by marking it on the map.
This can be done manually by double-clicking on the map to mark the object’s location or
by using the search field and entering the required address (Fig. 2.127).
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Fig. 2.127: Linking an address to the task

Important: Parameters marked with “*” are mandatory when creating a task. If the “Save”
button remains inactive after filling in the fields, a tooltip in red appears in the lower left
corner of the task creation window describing the reason for this behaviour and how to
correct it. This can occur if one of the mandatory fields is not filled in, or if the contract
and the type of work or the contractor organization do not match.

3. Click “Save.” After that, the task is created and sent to the server. If you click “Save
and continue,” the task is also created and sent to the server, but the window remains
open for the subsequent task creation. The created tasks are displayed in the general
task list.

2.8.2 Create tasks by uploading geotagged photos

To create tasks by uploading geotagged photos, follow these steps:

1. Prepare a folder on your PC containing geotagged photos. A task is created in the
system for each photo added to the folder.

2. Select the “Loading from GPS camera. . . ” tab in the “Options” menu.

3. In the “Loading from GPS camera. . . ” window (Fig. 2.128), specify the task parameters
in the corresponding fields: “Title”, “Text of the task”, “Priority”, “Type”, “Organiza-
tion”.
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Fig. 2.128: Loading from GPS camera

4. Click “Select folder” and navigate to the folder containing the geotagged photos to be
attached to the task.

The message “Loading is complete! A message was created” indicates the successful com-
pletion of the process. Created tasks appear in the general task list.

2.8.3 Creating tasks using a time-lapse recorded in ActiveMap Mobile
app

To create new tasks based on a timelapse, you have to:

1. Go to the previously created task to which a timelapse is attached and double-click on
the icon of the video of interest. A player window opens, allowing to simultaneously
view the device’s movement track and its location at the time the current frame was
recorded (Fig. 2.129).
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Fig. 2.129: Timelapse view window

2. Start playing the video or use the frame-by-frame navigation buttons to

reach the desired frame/location on the track, and then pause the playback . If
necessary, you can increase the playback speed by clicking on one of the corresponding

buttons .

3. Click “Create task” at the bottom of the player window (Fig. 2.129). A task creation
form opens with a video frame added as a photo. The coordinates of this frame become
the task location.

2.8.4 Mass task creation and updating using an Excel spreadsheet

2.8.4.1 Creating tasks using an Excel spreadsheet

Mass task creation can be carried out based on a template or without one, using the original
Excel spreadsheet.

To obtain a template, you need to:

1. Go to the “Options” menu section -> “Import” -> “Save template. . . ” The template is
an Excel spreadsheet.

2. Fill in the obtained template. The first rows of the table show examples that can be used
to fill in the rest of the rows (Fig. 2.130). For fields of type “refrence table (dictionary)”,
you can select values from the drop-down list instead of entering them manually. When
filling in the fields, it is important to remember that the performer should belong to the
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assigned organization, and the custom fields should correspond to the selected work
type. If there is no such correspondence when the file is uploaded to the system, an
error occurs.

Fig. 2.130: Template for mass task creation

3. Save and close the edited Excel spreadsheet.

You can also upload the original *.xlsx file. To import, the first row of the file should contain
the column headings.

To import the template or the original Excel spreadsheet, go to the “Options” menu -> “Im-
port” -> “Import tasks from MS Excel”, and choose the table you want to import. A preview
window opens (Fig. 2.131).

Fig. 2.131: Preview window for importing tasks from MS Excel
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When logging in under an account with an “Administrator” role, it is necessary to select
the corresponding creator organization from the drop-down list. By default, the program
determines the worksheet from which data is imported, as well as the range for the upload.
If necessary, you can specify a different range (the first row must be the header) and click
“Recalculate”. Next, in the preview window, you have to specify column correspondences.
If the column names match, the application automatically sets correspondences for such
columns.

To geolocate a task, select one of the suggested methods:

• Obtain coordinates by address (select the field from the drop-down list to be used for
geocoding);

• Choose the combined field of latitude and longitude (select the field that contains ge-

ometry in the specified format from the drop-down list (hovering over will display
a hint);

• Choose the fields “Latitude” and “Longitude” (select the fields that contain geometry

in the specified format from the drop-down list (hovering over will display a hint).

It is also possible to use the table field to specify the coordinates and to fill in the custom
task field at the same time. Once all values have been marked, press “Load” to start import,
“Close” to cancel. If the button is inactive, a message appears at the bottom of the window
explaining why the button is disabled. This message is displayed in the “Import/update
tasks”, “Import from MS Excel” and “Import/update objects” windows. The import is not
possible if the imported table has multiple fields with the same name.

After confirming the upload, the tasks are imported into the system and displayed in the
general task list.

2.8.4.2 Updating tasks using an Excel spreadsheet

To update tasks using an Excel spreadsheet, you should first export the existing tasks to a
*.xlsx file:

1. Go to the “Options” menu -> “Export” -> “Export to MS Excel” or click the “Export

to MS Excel” button in the task list area.

2. Edit the table without changing the task IDs, the number of columns, and the column
names.

3. Save and close the edited Excel spreadsheet.

To import a table, go to “Options” -> “Import” -> “Update tasks from MS Excel” and select
the table of interest. A preview window (Fig. 2.132) opens, similar to the window that
appears when importing tasks from MS Excel.

2.8. Adding new tasks 100



ActiveMap Desktop user manual 3.32.1

Fig. 2.132: Preview window for updating tasks from MS Excel

In this window, you should define the parameters described above. You can also enable the
deletion of custom fields if the selected MS Excel table cells are empty. Click “Load” to start
importing the file with the updated data, and “Close” to cancel the import. After confirming
the upload, the tasks will be updated in the system.

2.8.5 Creating tasks in the Service object window

When creating tasks linked to service objects, the task fields are automatically filled in ac-
cording to the configured mapping (the correspondence between the layer attribute and the
task field). To create tasks linked to service objects, follow these steps:

1. Go to the “Service Objects” menu section and select the desired layer from the list. A
window opens with a list of objects in the selected layer and a map with their location
marks (Fig. 2.133).
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Fig. 2.133: Service objects window

2. To create a task linked to a service object, first select the object of interest in the list by
clicking on it with the left mouse button or on the map, after clicking the “Select on the

map” , “Select rectangle on the map” , or “Select polygon on the map” button

. Then, the “Create task” button becomes active in the bottom part of the window.
Alternatively, double-click on the object name in the list and click the “Create task”
button in the object window that opens.

After clicking the “Create task” button, the task creation window opens with automatically
entered information about (Fig. 2.134):

• task title (the field contains the name of the service object, it can be edited);

• selected service object;

• task coordinates that match the coordinates of the service object.

The remaining fields should be filled in manually. Only the main task fields are displayed
in the window. Mandatory fields are marked with an asterisk (*). After filling in the re-
quired fields, the “Save” and “Save and continue” buttons are activated. Click one of them
to complete the task creation process.
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Fig. 2.134: Task creation window linked to service object

3. To create several tasks linked to different service objects, select the objects of interest

in the list using the “Shift” or “Ctrl” keys, or on the map using the rectangle or

polygon selection tool and click “Create task”. If you need to create tasks linked
to all the service objects in the layer, go to the “Options” -> “Create tasks for all in the
list” tab in the service object layer window (Fig. 2.135).

Fig. 2.135: Creating tasks for all objects in the list

After performing any of these actions, the task creation window appears (Fig. 2.136).
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Fig. 2.136: Task creation window linked to service objects

The window that opens specifies the service object layer to be used and the number of se-
lected objects for which tasks are created. If mass creation is carried out, both main and
custom task fields can be filled in. After selecting a task type, the fields “Organization” and
“Creating organization” show only those organizations that have access to the marked task
type, the others are hidden.

Important: When filling in the “Contracts” field, select only those service objects that are
listed in the contract. If the selected service objects are not listed in the contract, tasks will
not be created for them.

If the “Title” field is left blank, the titles of the created tasks will be the same as those of the
linked service objects. If this field is left blank, all created tasks will have the same title. If
the “Deadline” field is left blank, a default date (3 days) will be automatically assigned.

Mandatory fields are marked with the symbol “*". After filling in the required fields, the
“Create” button is activated. Created tasks appear in the general task list. The coordinates
of each of the tasks match the coordinates of the associated service objects.
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2.9 Creating and editing schedules

Schedules allow to automatically generate tasks based on templates at a certain time with the
required frequency. Task templates are samples of tasks that will be created according to the
schedule. Creating and editing schedules and task templates are available for the following
roles:

• Chief Administrator,

• Cluster administrator,

• Organization administrator,

• Chief inspector,

• Cluster inspector,

• Organization inspector.

2.9.1 Adding tasks to a new schedule

To add one or more tasks to the new schedule, select them in the list of tasks (check the box
next to the task number) and go to “Schedules” -> “Add to new schedule” menu section or
select the “Add to new schedule” operation from the drop-down list in the lower right corner
of the task list area. The “Schedule creation” (Fig. 2.137) window opens.

Fig. 2.137: “Schedule creation” window
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The window includes 3 areas:

1. Schedule parameters.

2. Template list.

3. Launch calendar.

To create a new schedule, you need to set its parameters:

• Name.

• Deadline (days, hours, minutes).

• Schedule enable flag - checking the “On” checkbox makes the schedule active.

• Creation time - selected from the drop-down list. After selection you can adjust the
minutes value in the field, after which you have to click the “Add” button. The added
time should be displayed below the drop-down list.

• Organization - selected from the drop-down list. The user to whom the task will be
assigned should belong to the selected organization. If the user does not belong to the
organization, the task cannot be generated.

• Contract - selected from the drop-down list of available contracts. The schedule ac-
cording to the contract, like the contract itself, is created at the cluster level. If you
delete its contract in ActiveMap Web, the schedule is automatically considered as
deleted, but the tasks created according to this schedule are saved. If the schedule is
created according to the contract, the “Organization” field is not filled in. If the sched-
ule is not created according to the contract, the organization must be selected. After
creating tasks according to the schedule with the attached contract, it is not possible to
change the serviced object or work type in them.

• Launch generation period - sets the period for creating tasks with the indication of
the days of the week for generation. After selecting the days, click “Add”. The selected
days should be displayed in the launch calendar area.

The template list area includes “Templates” and “Tasks for converting to templates” tabs.
The selected tasks are displayed in the second tab. At the bottom of the area there are but-
tons with operations that can be applied to selected templates and tasks for converting to
templates:

• “Change file stickers” - replace photo stickers in tasks;

• “Create/Create a copy” - create a new template or copy and edit one of the attached
(the operation is not available for tasks for converting to templates);

• “Open” - open a template or task for converting into a template (if necessary, you can
edit and save the opened template/task);

• “Remove” - delete a template or task for converting into a template.

After setting all the necessary parameters, click “Create”. After the selected tasks are con-
verted to templates, they are no longer displayed in the general list of tasks. The resulting
templates can be viewed and edited by switching to the task templates mode (“View” ->
“Mode of work with task templates” menu section).
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2.9.2 Working with existing schedules

To edit schedules, go to “Schedules” -> “Manage schedules” menu section. The “Schedule
list” (Fig. 2.138) window opens, where you can create, search, edit and delete schedules, and
view the results of template task launches.

Fig. 2.138: “Schedule list” window

The window includes 3 areas:

1. Panel for filtering schedules.

2. List of schedules.

3. Launch calendar.

Double-clicking on a date in the calendar opens the list of launches for that day. (Fig. 2.139).
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Fig. 2.139: “Runs list” window

This window shows launches, templates used, and task steps. If a task has not been created,
a red icon with the number of tasks in the “Not created” step appears in the left part of the
window. Clicking on this card displays the templates for created tasks on the right side of
the window. Here you can see the reasons why the task was not created (for example, if the
type of work, contract, organization, or performer does not match).

If the task was not created, you can restart the template creation. To do this, you need to
edit the selected template and then click “Restart”. If necessary, you can delete the template
from the schedule. It is also possible to edit the schedule itself by selecting it in the list
of launches and clicking “Edit”. The “Schedule change” window opens (Fig. 2.140). This
window can also be opened by double-clicking on the schedule of interest in the “Schedules
list” window.
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Fig. 2.140: “Schedule change” window

In the opened window, you can change the name, deadline, time, and period of generating
launches, as well as select one of the attached templates using the filter by templates. At-
tached templates can be opened, edited, saved, and deleted. You can also change file stickers.
In addition, in the current window, it is possible to create a new template or copy and edit
one of the existing templates.

To edit existing schedules by adding tasks selected in the task list area to them, use the “Add
to schedule” operation from the drop-down list in the lower right corner of the task list area
(Fig. 2.141).
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Fig. 2.141: Adding tasks selected in the list area to the schedule

After clicking on the “Add to schedule”, the “Schedule list” window opens (Fig. 2.138),
where you can select the schedule to which the selected tasks will be included. To select
a schedule from the list, left-click on it and press “Select” (Fig. 2.142). You can use the
filter bar on the left side of the “Schedule list” window to make it easier to find the desired
schedule.
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Fig. 2.142: Selecting a schedule for adding tasks
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2.10 Completion of work

To exit the program (complete the work), close the window using the button located
in the upper right corner of the ActiveMap Desktop window, or click “Exit” in the “File” tab
on the toolbar.
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THREE

GLOSSARY

Applied software suite is a set of interconnected programs designed to solve problems of a certain class
of a particular subject area and interact with the user.

Attribute data are values describing features of objects. Attribute data types: integer, real, text, date,
date and time, geometry.

Basemap is the dominant or underlying layer in a given map that provides geographical context to the
map and other dataset layers above it. Users visualize tasks, service objects, and thematic layers above
the basemap, as well as use it for navigation through a map and getting general information about the
area of interest.

Chief inspector is an employee responsible for managing tasks in the System.

Client Organization is an association of users who make their requests via the mobile application, mon-
itor their status, are capable of evaluating the work performed. User rights for operating the System are
restricted.

Cluster is an association of several organizations for the purpose of enabling the in-process control of
the performance of departments.

Cluster administrator is an employee whose job responsibilities include the cluster management as
follows: control of organizations and users within his/her cluster, access right distribution to users within
his/her cluster to layers and reports, and the task management within his/her cluster.

Cluster inspector is an employee responsible for managing tasks within his/her cluster.

Clusterization is the representation of raster layer objects located nearby by a single label on a map.

Contract is an entity for accounting and planning the task accomplishment by organizations under con-
tractual obligations.

Custom fields are attribute fields which can be customized in the system versus features of a project
underway, and be referenced to certain work items.

Data table is a structured database of same-type objects within the bank of spatial data.

File label (sticker) is a textual mark in a picture.

Invitation (an invite link) is a link containing information on the server address, login, and password of
a user to simplify the process of authorization in the mobile application.

Layer is a visual representation of geographical data in the environment of any digital map.

Layer group is a set of layers grouped according to thematic or other specified criteria.
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LDAP (Lightweight Directory Access Protocol) is an open, vendor-neutral, industry standard applica-
tion protocol for accessing and maintaining distributed directory information services over an Internet
Protocol (IP) network.

Legend is a set of symbols and explanations on a map.

License is a file containing information on the acceptable quantity of users, validity period, and allowing
to link the server software of the System to the equipment.

Organization administrator is an employee whose job responsibilities include the management of
his/her organization as follows: the creation of users, the provision of access to layers and reports within
his/her company, and the task management within his/her company.

Organization inspector is an employee responsible for managing tasks within his/her company.

Organization user is an employee who uses the System to accomplish assigned tasks.

Raster layer represents data in the form of geographically-referenced images as well as fragments of
raster images displayed in the same projection and prepared for each level of map detail.

Reference table is a systematic data table intended for facilitating users to handle attribute information
on objects.

Service objects are layers containing objects of interest of the user organization due to their relation to
business activity of the involved organization.

Schedule is a tool that enable to automatically create and assign template tasks at a certain time with a
specified periodicity.

The System administrator is an employee responsible for configuring the System: managing clusters,
organizations, users of all roles, reference tables for tasks (work types, stages, priorities, custom fields,
stickers), as well as the distribution of access rights to layers and reports.

Thematic layer is a spatial data bank layer which objects are interrelated by the same topic.

Timelapse-video is a video file comprising a series of pictures took via a video camera during a long
time period.

User tags is an entity allowing to group users against a specified attribute (e.g., the phone model).

User type is a user characteristic (a human being or a vehicle) to determine the user mapping settings
versus the type selected.

Vector image is a representation of graphical objects and images based on the use of geometric primitives
such as points, lines and polygons.
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organization inspector, 5, 114
organization user, 5, 114

P
printing tasks, 60, 78
program language, 54
program settings, 52
proxy server settings, 6
proxy settings, 6
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reports, 14
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service object filter, 63
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task search, 23
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